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NorthClark Computing, Inc. 

Introduction 
NorthClark's Capacity Planning and Scheduling program is designed to help you manage the production 
schedule and identify situations where your available resources may be over or under utilized.  This 
program is designed to streamline the process of managing the production process.  The Capacity 
Planning and Scheduling program is a Windows based desktop application that may be used to view, 
create, and modify Work Order, Project and Miscellaneous schedules in your Manfact system.  Key 
features of this application include: 

� Ability to load any combination of Manfact Work Orders, MRP Planned Orders and Project Budgets 
(estimate to complete),  to create a schedule.   

� Add user-defined “miscellaneous tasks” to the schedule. 

� Available capacity is entered by user-defined “Capacity Centers”.  Multiple work centers and 
resources may be rolled-up to load a single Capacity Center. 

� Labor and machine hours may be rolled up to different Capacity Centers, allowing these constraints 
to be analyzed separately for a group of work centers. 

� The Manfact shop calendar is used to identify normal workdays, holidays, and shutdown days. 
Different Capacity Centers may use different calendars if desired.  A Capacity Override feature 
allows you to enter exceptions to the calendar such as planned overtime. 

� Capacity is entered by shift, and the schedule is loaded by shift to account for variances in crew sizes 
throughout the day. 

� Operation scheduling options include: Start When Previous Operation Complete (traditional), Spread 
Over Life of Work Order / Task, Concurrent With Previous Operation, Forward Schedule From 
Work Order Start Date, Backward Schedule From Work Order End Date. 

� A graph may be displayed to highlight Capacity Centers that are over/under capacity.  From here, the 
user may drill-down to see the work orders or tasks that impact a Capacity Center, make changes to 
schedule dates as desired, and recalculate the plan. 

� Capacity and scheduling reports by Production Group are generated in the form of an Excel 
spreadsheet. 

� At the user’s request, schedule date changes are automatically posted to Manfact work orders and 
projects. 

� Ability to define predecessor/successor relationships between tasks and/or work orders. 
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Quick Start Guide 
Following is a brief outline of the steps necessary to create your first Capacity Plan and Schedule using 
the NorthClark system: 
 

1. Choose Open/Create Database from the File menu.  Browse to any desired folder on your 
network and create a new Capacity Planning database. 

2. Choose Processing Options from the Processing menu.  Define your plan dates, and select from 
a variety of planning options. 

3. Choose Load Resources From Manfact from the Tools menu.  If your plan will include Work 
Orders, then choose the option to load Work Centers.  Repeat this step and choose the option to 
load Resource Codes if your plan will include Projects. 

4. Choose Create Capacity Centers from the Tools menu.  Choose Create One Capacity Center 
per Work Center for a detailed plan, or Create One Capacity Center per Department for a 
summarized plan. 

5. Review the available capacity figures on the Cap. Centers tab and update if necessary.  In 
particular, correct any entries where the available capacity is zero. 

6. Click the Save icon on the toolbar, or choose the Save Changes and Post Later option on the 
File menu at anytime during this procedure to save your work. 

7. Choose Load Projects, WO’s and MRP from the Processing menu to import information from 
your Manfact system according to the Processing Options your entered. 

8. Choose Calculate Capacity Plan from the Processing menu. 

9. Identify Capacity Centers that are over/under utilized by viewing the information on the Cap. 
Results and Load Detail tabs. 

10. Output the plan as a graph or Excel spreadsheet by selecting options from the Graph and Reports 
menus. 
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Main Menu Options 
Following is a brief description of the options available from the Main Menu of the Capacity Planning 
application. 

Menu Option Description 

File Open/Create a 
Database 

Opens an existing Access file or allows the user to create a new 
one. 

 Save Changes and 
Post Later 

Choose this option to save your schedule and capacity planning 
information to a database on your local hard-drive or network 
folder.  This allows you to save your work, and pick-up where 
you left off at a later time. 

 Revert to Last Save This option will restore your schedule to its condition as of the 
last time you saved it to disk. 

 Print Current Display Output the active spreadsheet to the printer. 

 Export to Excel Export data from the active spreadsheet to Microsoft Excel™. 

 Exit Close the application 

Edit Copy Copy data to the Windows clipboard.   

 Cut Cut data from the field and copy it to the Windows clipboard.   

 Paste Paste data from the Windows clipboard.   

 Fill Update all of the selected cells from the Windows clipboard.   

 Zoom View, print and/or edit the expanded contents of a field.   

 Add a Row Insert a Row 

 Delete a Row Delete Current Row 

View Expand All Expand and show all levels of the project. 

 Collapse All Collapse all of the lower level items and show only the top-level 
project. 

 Unhide All Columns Expose all columns previously hidden. 
 

 Auto Fit Columns Automatically adjust the width of each column to accommodate 
your data.  

 Display Options Set user preferences affecting the appearance of the screen. 

Processing Load Projects, WO’s 
and MRP 

Imports current load information from the Manfact system. 

 Calculate Capacity 
Plan 

The system calculates over/under utilization of each resource by 
time period. 
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Menu Option Description 

 Post Schedule 
Changes to Manfact 

Update Manfact Work Order and Project information based on 
the new Schedule. 

 Processing Options Establish planning horizon and enter various planning parameters 

Tools Add a Budget Row 
to a Project 

Insert a new budget line into an existing Project. 

 Add a Misc Task to 
the Schedule 

Add a new, user-defined Task to the Schedule. 

 Delete Task(s) From 
Schedule 

Removes an item from the Schedule (does not affect Manfact) 

 Load Resources 
From Manfact 

Copy a list of Work Centers and/or Project Resource codes from 
the Manfact system. 

 Create Capacity 
Centers 

Use this utility to quickly create new Capacity Centers based on 
Work Center data. 

 Update 
Manufacturing 
Calendar 

Synchronizes the Schedule Calendar with the Manfact 
Manufacturing Calendar 

 Reschedule All Recalculates the Schedule Start and/or End Dates for each Task 
based on the Schedule Method chosen for each Task. 

 Roll Up Project 
Schedule Dates 

For multi-level projects, a parent project’s start/end dates are 
adjusted to match the earliest/latest dates of all sub-projects. 

 Reschedule WO’s 
Within Project Dates 

Work Order start/end dates are adjusted to so they fall within the 
start/end dates of a parent project. 

 Push Start Dates 
Forward to Plan Start 

If a Task Start Date is less than the Plan Start Date, the Task Start 
Date is made equal to the Plan Start Date. 

 Find a Task to 
Schedule 

Search for a text string within any column on the schedule to 
locate a Task. 

Graph By Time Capacity Utilization Graph by Time 

 By Center Capacity Utilization Graph by Capacity Center 

Reports Production Group 
Definition 

Organize Capacity Centers into Production Groups for reporting 
purposes. 

 Generate Production 
Capacity Workbook 

Generate a Capacity Planning Report in the form of an Excel 
spreadsheet. 
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Spreadsheet “Right Click” Menu 
These options are displayed when you right-click on the spreadsheet entry form: 
 

Copy Copy data to the Windows clipboard.   

Cut Cut data from the field and copy it to the Windows clipboard.   

Paste Paste data from the Windows clipboard.   

Fill Update all of the selected cells from the Windows clipboard.   

Reschedule Project Schedule Tab Only – Allows you to Reschedule a single line item. 

Sort by Ascending Right-Click on the column and you may sort the column in ascending order. 

Sort by Descending Right Click on the column and you may sort the column in descending order 

 
 
Capacity Planning and Scheduling 
The main screen is comprised of seven “tabs”: 

Schedule Displays a list of all tasks affecting your shop in outline format. 

Operations Displays the details of individual tasks and allows you to reschedule the whole 
task or operations within the task using multiple criteria. 

Cap Centers Allows you to define areas in your shop where you wish to monitor available 
capacity.  A Capacity Center may be a department, a work center, or any 
combination of work centers and/or project resource codes. 

Resources This screen contains a list of all of the resource codes and work centers used in 
your schedule.  Each item must be assigned a Capacity Center where labor and 
machine hours are to be posted. 

Capacity Override Use this screen to enter exceptions to normal working hours not already defined 
in the Manfact shop calendar. 

Capacity Results This screen is displayed when you choose the Calculate Capacity Plan option 
from the Processing menu. 

Load Detail From the Capacity Results screen, double click on any Capacity Center to see a 
list of tasks contributing load for the time period. 
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Schedule  
This screen displays your production schedule in outline format.  The estimated hours required to 
complete each task (ETC) will contribute load to the capacity plan.  

 

 
There are three ways to add a task to the schedule: 

� Select the Load Projects, WO’s and MRP From Manfact option from the Processing menu. 

� Select the Add a Budget Row to a Project option from the Tools menu. 

� Select the Add Misc. Task to the Schedule option from the Tools menu. 

Reschedule a Task 
The process of scheduling a project, work order, or MRP planned order accomplishes two main goals.  
First, it determines the number of work days required to complete the task (duration).  The duration 
determines either the end date or start date of the task depending on whether you are using forward or 
backward scheduling.  

The second goal of the scheduling operation is to calculate the number of labor and/or machine hours to 
be loaded into the Capacity Center for the dates work is scheduled to be performed.  So, even if a task is 
manually scheduled (meaning you will supply the start and end dates for the task), the system must 
“schedule” each task in order to calculate the load. 
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While viewing the Schedule Display, you may choose the Reschedule Task option from the pop-up 
menu that is displayed when you click the right mouse button.  The task to be rescheduled depends on 
which row is currently active.  For example, let’s say you want to reschedule work order number 12345.  
Begin by clicking on any cell on any row for this work order (either the work order itself or the 
operations underneath it).  Now when you right-click to view the pop-up menu, you will see an option to 
“Reschedule WO 12345”.  

The following columns are displayed: 

Column Name Description 

[+] or [-]  Click on the plus/minus button to expand or collapse your view of a project, 
work order, or MRP planned order in your schedule. 

Level The outline level of the task.  

Top-Level 
Project/Group 

For Projects and Work Orders, the top-level Project Number is displayed.  
For MRP planned orders, the Planning Group is displayed. 

Load Type Each line will be one of the following types:  

Project: A project summary line representing the totals of all Budget and 
Work Order lines beneath it. 

Budget: This line includes Estimate to Complete (ETC) hours from the 
Manfact PROJBUD file. 

Work Order: A summary line representing the totals of all operation steps 
included on the work order. 

Oper: One step on a work order routing. 

MRP: A summary line representing the totals of all operation steps included 
on an MRP planned order. 

MRP Oper: One step on the routing for an MRP planned order. 

Misc: A miscellaneous task added by you. 
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Column Name Description 

Task Identifier The identifier is different for each type of load:  

Project: Project Number 

Budget: Resource Code (and optionally fiscal period) 

Work Order: Work Order Number 

Oper: Work Center (Dept * Operation) 

MRP: MRP Planned Order Number 

MRP Oper: Work Center (Dept * Operation) 

Misc: User defined 

Description Project: Project Description 

Budget: Resource Description 

Work Order: Assembly (Parts) Description 

Oper: Work Center Description 

MRP: Assembly (Parts) Description 

MRP Oper: Work Center Description 

Misc: User defined 

Assembly Number The Assembly (Part) Number is displayed for Work Orders and MRP 
Planned Orders. 

Status The status of a Project or Work Order: New, Firm Planned, Released, or 
Backordered. 
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Column Name Description 

Schedule Method Choose the Scheduling Method you want to use for each task from the drop-
down window. 

Forward from WO/Task Start:  The system calculates the Due Date of the 
order by forward scheduling each operation from the specified Start Date. 

Backward from WO/Task Due:  The system calculates the Start Date of 
the order by backward scheduling each operation from the specified Due 
Date. 

MANUAL (NO CALCULATION):  BOTH THE START AND DUE 
DATE ARE SUPPLIED BY THE USER.  THE SYSTEM PERFORMS 
NO AUTOMATIC SCHEDULING CALCULATION. 

Do Before Rows You may specify one or more tasks that cannot be started until this task is 
complete (successors).  Enter the Row Number for each task, separated by 
commas. 

Do After Rows You may specify one or more tasks must be completed before this task starts 
(predecessors).  Enter the Row Number for each task, separated by commas. 

Required Date For Projects and Work Orders, the system obtains the earliest date from any 
sales orders tied to the work order or project.  For MRP planned orders, the 
MRP Due Date is used.  You may change this date if desired. 

Schedule Start Date When using Forward or Manual scheduling, enter the scheduled start date 
for the task. 

Schedule Due Date When using Backward or Manual scheduling, enter the scheduled due date 
for the task. 

Work Days The system calculates the number of working days between the Start Date 
and the Due Date based on the Calendar. 

Original Start Date The scheduled start date that was assigned to the task when the data was 
loaded from Manfact. 

Original Due Date The scheduled due date that was assigned to the task when the data was 
loaded from Manfact. 

Original Duration The system calculates the number of working days between the Original 
Start Date and the Original Due Date based on the Calendar. 

Qty Based on the line type, this column displays the Work Order Quantity, MRP 
Planned Order Quantity, or Operation Quantity. 
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Column Name Description 

Setup Hours For Work Order and MRP Operations, remaining setup hours are loaded 
from the routing. 

Run + Rework Hours For Work Order and MRP Operations, remaining labor and rework hours are 
loaded from the routing.  For budget lines, estimate to complete hours are 
loaded from the PROJBUD file. 

Machine Hours For Work Order and MRP Operations, remaining machine hours are loaded 
from the routing.  Although there is no mechanism for budgeting machine 
hours in Manfact, you may enter machine hours for budget lines in this 
application if desired.  Your entries will be recalled if the budget is loaded 
again in the future.  

Line Hours Clock-time to complete this task is calculated by dividing either Labor or 
Machine Hours (depending on the Scheduling Method you selected) by the 
Maximum Crew Size. 

Actual Labor Hours The actual labor hours posted to a work order or project are displayed and 
may not be changed. 

Actual Mach Hours The actual machine hours posted to a work order or project are displayed 
and may not be changed. 

ETC Labor Hours Setup Hours + Labor Hours – Actual Labor Hours 

ETC Mach Hours Machine Hours – Actual Machine Hours 

ETC Line Hours Clock-time to complete this task is calculated by dividing ETC Labor or 
Machine Hours (depending on the Scheduling Method you selected) by the 
Maximum Crew Size. 

Percent Complete Actual Hours / Estimated Hours 

Queue Time Interoperation time or “lag” time increases the duration of the task without 
adding additional load to the capacity plan.  Queue time occurs before the 
task begins. 

Move Time Interoperation time or “lag” time increases the duration of the task without 
adding additional load to the capacity plan.  Move time occurs after the task 
is completed. 
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Operations  
Use this screen to work with individual rows from the Schedule Display. 

 
 
You may choose to reschedule the operations on this display. 

� Select the scheduling method from the drop-down window. 

� Enter the new scheduling date. 

� Click on the [Reschedule] button to reschedule the Operations. 

The following columns are displayed: 

Column Name Description 

Operation The Work Center(s) or Resource associated with this task. 

Description The description of the Work Center 
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Column Name Description 

Schedule Method Choose the Schedule Method from the drop-down window. 

After Prior Operation Complete:  This is the method Manfact uses for 
Work Order and MRP Planned Order operations.  This method assumes that 
each step will be performed serially in the sequence of the routing. 

Spread Over Life Of Wo Task:  After all other “serial” operations have 
been scheduled, the system sets the operation’s start and due dates equal to 
the start and due dates of the project or work order.  For capacity loading, 
the total number of hours estimated for the operation are spread evenly over 
the duration of the task. 
 
Concurrent With Prior Oper:  After all other “serial” operations have 
been scheduled, the system sets the operation start date equal to the start 
date of the previous step.  The operation is then forward scheduled from that 
point.  

Forward from WO/Task Start:  After all other “serial” operations have 
been scheduled, the system sets the operation start date equal to the start 
date of the parent project or work order.  The operation is then forward 
scheduled from that point. 

Backward From WO/Task Due:  After all other “serial” operations have 
been scheduled, the system sets the due date equal to the due date of the 
parent project or work order.  The operation is then backward scheduled 
from that point. 

Manual:  Both the Start and Due Date are supplied by the user.  The system 
performs no automatic scheduling calculation. 

Schedule Start Date The date this operation is scheduled to begin. 

Schedule Due Date The date this operation is scheduled to be complete. 

Work Days The system calculates the number of working days between the Start Date 
and the Due Date based on the Calendar. 

Qty Based on the line type, this column displays the Work Order Quantity, MRP 
Planned Order Quantity, or Operation Quantity. 

Labor or Machine Defines whether work center is a labor or machine work center or resource. 

Crew Size Enter the number of individuals who work in this work center or resource. 

Setup Hours For Work Order and MRP Operations, remaining setup hours are loaded 
from the routing. 
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Column Name Description 

Run & Rwk Hours For Work Order and MRP Operations, remaining labor and rework hours are 
loaded from the routing.  For budget lines, estimate to complete hours are 
loaded from the PROJBUD file. 

Mach Hours For Work Order and MRP Operations, remaining machine hours are loaded 
from the routing.  Although there is no mechanism for budgeting machine 
hours in Manfact, you may enter machine hours for budget lines in this 
application if desired.  Your entries will be recalled if the budget is loaded 
again in the future.  

Line Hours Clock-time to complete this task is calculated by dividing either Labor or 
Machine Hours (depending on the Scheduling Method you selected) by the 
Maximum Crew Size. 

Actual Labor  The actual labor hours posted to a work order or project are displayed and 
may not be changed. 

Actual Mach  The actual machine hours posted to a work order or project are displayed 
and may not be changed. 

ETC Labor  Setup Hours + Labor Hours – Actual Labor Hours 

ETC Mach  Machine Hours – Actual Machine Hours 

ETC Line  Clock-time to complete this task is calculated by dividing ETC Labor or 
Machine Hours (depending on the Scheduling Method you selected) by the 
Maximum Crew Size. 

% Comp Actual Hours / Estimated Hours 

Queue Time Interoperation time or “lag” time increases the duration of the task without 
adding additional load to the capacity plan.  Queue time occurs before the 
task begins. 

Move Time Interoperation time or “lag” time increases the duration of the task without 
adding additional load to the capacity plan.  Move time occurs after the task 
is completed. 

Seq # Sequence Number of the work center in this task. 

Occurrence Number of occurrences of this work center in the task. 
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Capacity Centers  
Use this screen to define areas in your shop where you wish to monitor available capacity.  A Capacity 
Center may be a department, a work center, or any combination of work centers and/or resources.  

 
 
There are two ways to add to your list of Capacity Centers: 

� Select the Add Row option from the Edit menu and type the required information into each cell.  
The new row will be added to the end of the spread.  This option will allow you to create 
capacity centers that are not tied to Manfact Departments or Work Centers 

� Select the option to Create Capacity Centers from the Tools menu.  This option will require you 
to create capacity centers to either Manfact Departments or Work Centers. 

Each Capacity Center may be used to measure either Labor or Machine capacity.  If you wish to monitor 
both labor and machine hours for a given work center or department, you will need to define two 
Capacity Centers. 

Enter the following information for each Capacity Center: 

Column Name Description 

Capacity Center Capacity Centers are user defined.  For example, a Capacity Center might 
represent a department, a group of work centers, a group of Machines, or a 
single work center or machine. 
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Column Name Description 

Description Enter a description of this Capacity Center 

Labor or Machine Select whether Labor or Machine hours will be used to load this Capacity 
Center from the drop-down window 

Calendar Code Optionally, you may specify a valid Manfact Calendar Code to be used for this 
Capacity Center.  If you leave it blank, the Calendar specified in the Process 
Options screen is used. 

Total Capacity  The total number of hours available per day is calculated for all shifts as:  
Shift 1 Total + Shift 2 Total + Shift 3 Total 

Availability % Enter the % of available capacity for the capacity center. 

Shift 1 Crew Enter the number of people or machines available on first shift. 

Shift 1 Hours  Enter the total man-hours or machine-hours available per day per man or 
machine on this shift. 

Shift 1 Eff % Enter the percentage that is used to reduce the total capacity available per day 
to account for non-production activities. 

Shift 1 Total Crew Size X Hours per Day X Efficiency Percent 

Shift 2 Crew  Enter the number of people or machines available on second shift. 

Shift 2 Hours Enter the total man-hours or machine-hours available per day per man or 
machine on this shift. 

Shift 2 Eff % Enter the percentage that is used to reduce the total capacity available per day 
to account for non-production activities 

Shift 2 Total Shift 2 Crew Size X Hours per Day X Efficiency Percent 

Shift 3 Crew Enter the number of people or machines available on second shift. 

Shift 3 Hours  Enter the total man-hours or machine-hours available per day per man or 
machine on this shift. 

Shift 3 Eff % Enter the percentage that is used to reduce the total capacity available per day 
to account for non-production activities 

Shift 3 Total Shift 3 Crew Size X Hours per Day X Efficiency Percent 
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Resources  
This screen contains a list of all of the resource codes and work centers used in your schedule.  Each 
item must be assigned a Capacity Center where labor and machine hours are to be posted.  

 
 
There are three ways to add resources to your list: 

� Select Add a Row from the Edit Menu and type the required information into each cell. 

� Select the option to Load Resources From Manfact from the Tools menu. 

� When you choose the option to Load Projects, WO’s and MRP From Manfact, any Work Centers 
or Resource Codes not already in your list are loaded automatically. 

Note, when the program loads resources automatically, you will still need to update this screen 
with Capacity Center information for each resource. 

Enter the following information for each Resource: 

Column Name Description 

Resource Type Select “W” for a Work Center, or “R” for a project Resource Code from the 
drop-down window.  This information will be filled in automatically when 
the information is loaded from Manfact. 
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Column Name Description 

Work Center / Resource Enter a valid Manfact Work Center or Resource Code. 

Description A description of this work center or resource is displayed. 

Capacity Center - Labor Enter the Capacity Center where you wish to post Labor Hours. 

Capacity Center - 
Machine 

Enter the Capacity Center where you wish to post Machine Hours. 

Schedule Method Choose the Scheduling Method you want to use as a default for this resource 
from the drop-down window.  

(See Operations Display for a description of the Scheduling Method options)

Crew Size For resource lines only, enter a default crew size. 

 

Capacity Override  
Use this screen to enter exceptions to normal working hours not already defined in the Manfact shop 
calendar. 
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To create a row select Add a Row from the Edit Menu.  This will add a row at the end of the spread. 
 
Enter the following information on each row: 

Column Name Description 

Capacity Center Enter the identifier of the Capacity Center you wish to affect. 

From Date Enter the effective date of this capacity override. 

To Date Enter the end date of this capacity override.  Information will be ignored after 
this date 

Applies To Select which days you want this override instruction to apply to: 

� All Dates in Range 
� All Normal Work Days in Range 
� All Non-Work Days in Range 
� Saturday 
� Sunday 
� Monday 
� Tuesday 
� Wednesday 
� Thursday 
� Friday 

Total Capacity  The total number of hours available per day is calculated for all shifts as:  

     Shift 1 Total + Shift 2 Total + Shift 3 Total  

Availability % Enter the % of available capacity for the capacity center 

Shift 1 Crew  Enter the number of people or machines available on first shift.  The initial 
value will default to the standard capacity center crew but may be overridden 
here. 

Shift 1 Hours  Enter the total man-hours or machine-hours available per man or machine per 
day on this shift. 

Shift 1 Eff % Enter the percentage that may be used to reduce the total capacity available per 
day to account for non-production activities. 

Shift 1 Total Crew Size X Hours per Day X Efficiency Percent 

Shift 2 Crew  Enter the number of people or machines available on second shift. 

Shift 2 Hours  Enter total man-hours or machine-hours available per day per man or machine 
on this shift. 
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Column Name Description 

Shift 2 Eff % Enter the percentage that may be used to reduce the total capacity available per 
day to account for non-production activities. 

Shift 2 Total Shift 2 Crew Size X Hours per Day X Efficiency Percent 

Shift 3 Crew  Enter the number of people or machines available on third shift. 

Shift 3 Hours Enter total man-hours or machine-hours available per day per man or machine 
on this shift. 

Shift 3 Eff % Enter the percentage that may be used to reduce the total capacity available per 
day to account for non-production activities. 

Shift 3 Total Shift 3 Crew Size X Hours per Day X Efficiency Percent 

 

Capacity Results  
This screen is displayed when you choose the Calculate Capacity Plan option from the Processing menu.  
It shows you the variance between total load and available capacity for each Capacity Center, for each 
time bucket you defined using the Processing Options screen. 

 
Double-click on a row, or select it with the [Enter] key, to view Load Detail for a particular Capacity 
Center and time period. 
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The following information is displayed: 

Column Name Description 

Capacity Center Capacity Center identifier (user defined) 

Description Description of the Capacity Center 

Labor or 
Machine 

Defines whether the Capacity Center is a Labor or Machine Capacity Center. 

Period  The period of time represented by this bucket: Past, Day, Week, Month, Quarter, or 
Year. 

From Date The beginning date of this period. 

To Date The ending date of this period. 

Total Capacity The total available man-hours or machine hours available during the period. 

Released Hours Hours that have already been assigned to released work orders or projects. 

Planned Hours Hours that have been planned by MRP. 

Total Load The total number of hours loaded into this Capacity Center during the period. 

Variance Total Capacity – Total Load 
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Load Detail  
From the Capacity Results screen, double click on any Capacity Center to see a list of tasks contributing 
load for the time period.  

 
 
From here, you may double-click on any item, or select it using the [Enter] key, to jump to the line on 
the Schedule screen where the task appears. 
 
The following information is displayed: 

Column Name Description 

Top-Level Project 
or Planning Group 

For Projects and Work Orders, the top-level Project Number is displayed.  For 
MRP planned orders, the Planning Group is displayed. 

Project Number The project number this Work Order or Budget item is assigned to. 

Type Project, Work Order, MRP Planned Order, or Misc. task. 

Order Number Work Order or MRP Planned Order number. 

Description Assembly (Part) description 

Assembly Assembly (Part) number 
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Column Name Description 

Work Center or 
Resource 

The Work Center or Resource that contributed this load. 

Seq# The operation sequence number where a work center appears on the routing. 

Labor Hours Labor hours contributed during this time period. 

Machine Hours Machine hours contributed during this time period. 

Start Date Start Date of the operation. 

Due Date Due Date of the operation. 
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Capacity Planning Database 

Open / Create a Database 
Your schedule and capacity planning information are stored in a Microsoft Access Database.  Choose 
the Open/Create Database option from the File menu and use the Open Dialog to locate or create your 
file.  Note, the file name will default to the last database you opened. 
 

 
 
You can create a new database using this screen.  This feature is useful if you wish to save more than 
one schedule.  Simply type in a name at the file name prompt, and the system responds: 

 Unable to Locate File. Do You Wish to Create It? 

Click [Yes] to create the new database, or [No] to cancel. 

Save Changes and Post Later 
Choose this option to store your Capacity Plan and Schedule in your local Access Database, without 
updating the Manfact system. 

Revert to Last Save 
Choose this option to discard any unsaved changes, and restore your schedule to the condition it was in 
when you last saved. 
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Processing  

Processing Options 
This screen includes various options and parameters that affect the information that are loaded into your 
schedule, as well as how the capacity plan is calculated. 

 
 

Capacity Loading: 
There are six check-boxes displayed in the Capacity Loading section of the screen: 

� Include Work Orders 
� Include Projects 
� Include MRP Planned Orders 
� Exclude Unreleased Projects 
� Exclude Unreleased Work Orders 
� Exclude Expense Work Orders 

 
These options are considered when you choose the Load From Manfact option to update your schedule 
with any combination of Work Orders, MRP Planned Orders and Projects from your Manfact system. 
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Using Budget (Estimate to Complete) As Load: 
If you have elected to include projects in your schedule, you may also choose to use labor hours entered 
on the Project Budget file as load in your capacity plan.  The following options are provided: 

� Use Budget For Projects Without Work Orders 
� Use Budget For All Projects 
� Never Use Project Budget 

The first option will load the budget for all projects or sub-projects that do not have work orders 
associated with them.  The assumption here is that if one or more work orders are linked to the project, 
the work order routing will provide more detailed load information. 

If your company does not use work orders, or if accurate routing information is not available, you may 
prefer to load the budget for all projects.  Note, if you choose this option, be careful not to double your 
load by including both the budget and work orders for a project. 

The third option, never use project budget, is useful if you have chosen to load projects for the purpose 
of viewing your work order information in the context of the project structure, but want all of the 
schedule and load detail to be based on routings. 

Budget Revision Level: 
The Budget Revision Level is used when reading information from the Manfact PROJBUD file.  
Normally, you will want to leave this field blank to use the current version of the budget. 

Decimal Places: 
Enter the number of decimal places you wish to see displayed for labor and machine hours. 

Planning Buckets, Plan Start and End Dates: 
Use the four text boxes in this section to define the number of Daily, Weekly, Monthly, and Yearly 
buckets to be included in your planning horizon.  You may change these values by clicking on the 
up/down arrows next to each box, or by typing the desired value directly into each box. 

As you change the number of buckets, the start and end dates of each bucket are calculated based on the 
Plan Start Date.  These buckets are displayed on the Plan Dates tab shown on the right side of the screen. 
The Plan End Date is calculated and displayed by the system. 

Calendar: 
The Manufacturing Calendar is defined in the Manfact system using the TABLE.SHOPCAL entry 
screen. This includes the days of the week your company normally operates, as well as holidays and 
shutdown days. 

The Manfact system allows you to define multiple calendars.  For example, different plants might use 
different calendars.  If your company has defined more than one calendar, you will need to enter the 
name of the calendar you wish to use for this application.  Leave this field blank if your company uses 
only one calendar, or if you wish to use the default calendar. 

25 



NorthClark Computing, Inc. 

Automatically Reschedule Operations: 
The project schedule dates and the corresponding load on capacity centers must be updated any time you 
change critical information about a task.  This would include information such as estimate to complete 
hours, predecessor/successor relationships, etc. 

This routine creates one line in the schedule for each resource within a project.  However, when you 
enable the Automatic Reschedule Operations option, the system will perform these calculations 
immediately each time you make a change.  This may not be desirable if you are working with a very 
large schedule or a computer that is too slow. 

If you disable automatic rescheduling, you will need to select the Reschedule All option from the Tools 
menu periodically to calculate the schedule.  Please refer to the Scheduling Tools topic for more 
information. 

Automatically Roll-up Project Dates: 
Normally, you will want to enable this option so that your project start and end dates will be updated 
automatically when dates are changed on subordinate work orders.  However, you may wish to disable 
the automatic roll-up in the case where you wish to establish a start or end date for the project, then 
allow the corresponding work orders to inherit the project dates.  Please refer to the Scheduling Tools 
topic for more information. 

Use Budget Periods as Schedule Dates: 
This feature is intended for users who have time-phased their project budget in the Manfact system by 
fiscal period.  Normally, the Load From Manfact feature is enabled, a separate line is created for each 
resource and fiscal period.  The month start date and month end date for each period is used as the 
schedule dates for each row. 

Load Budget When ETC is Negative: 
Normally, only tasks with an Estimate to Complete (ETC) greater than zero are loaded into the schedule.  
Selecting this option allows you to include tasks where the total actual hours incurred to date exceed the 
budget amount. 

Load Operations with No Remaining Hours: 
Selecting this option allows you to include tasks where the actual hours exceed the planned hours. 

Automatically Remove Expired Capacity Override Entries: 
Selecting this option allows Capacity Override Entries with an end date prior to today’s date to be 
automatically removed when the database is opened. 
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Planning Groups, WIP Locations, Account Codes and Plan Dates: 
The tabs on the right side of the screen allow you to enter additional criteria to determine what 
information will be included in your schedule. 

� If you are loading Work Orders, you must select the WIP Location(s) to be included in the plan. 

� If you are loading MRP Planned Orders, you must select the Planning Group(s) to be included in 
the plan. 

� If you are loading Projects, you must select the Account Code(s) to be included in the plan. 

� You can view the Plan Dates to be included in your capacity plan by selecting Plan Dates. 

Load Projects, WO’s and MRP From Manfact 
Before selecting this option, you should visit the Processing Options screen and verify that you have set 
the processing parameters as desired.  

This process allows you to begin building your schedule using the information available from Manfact.  
You may load any combination of Projects, Budgets, Work Orders, and MRP Planned Orders.  
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Choose one of the following options to build your schedule: 

� Replace My Entire Schedule With the Latest Information From Manfact 
Choose this option the first time you run this procedure.  It will load your schedule according to the 
parameters you selected using the Processing Options screen. 

 
� Load Projects and Work Orders That Are Not Already in My Schedule 

Choose this option if you already have a schedule you are happy with, and you only want to load 
projects and work orders that have been recently added to Manfact. 
 

� Load and Replace a Project and All It’s Sub-Tasks and Work Orders 
This option may be useful if recent changes to a Project structure may impact your schedule. 
Enter the Project Number in the prompt called Project / Work Order to Load. 
 

� Load and Replace a Specific Work Order in My Schedule 
This option may be useful if recent changes to a work order may impact your schedule. 
Enter the Work Order Number in the prompt called Project / Work Order to Load. 
 

� Load and Replace All MRP Planned Orders in My Schedule 
If MRP has been run recently, you may wish to update the planned order information in your 
schedule, without affecting the project and work order information you have in place. 
 

� You may choose to keep or discard and Miscellaneous Tasks you may have created.  Check the Keep 
Miscellaneous Tasks box to preserve your entries. 

 
You may return to the Processing Options screen by clicking the [Options] button.  Click the [OK] 
button when you are ready to begin loading.  Note, depending on the volume of data, this process may be 
lengthy.   

Calculate Capacity Plan 
Once you have established your schedule, the next step is to calculate the capacity plan to determine if 
sufficient resources are available to complete each task.  The following activities must be completed 
before performing this function: 

� In your Manfact system, use the TABLE.SHOPCAL and MFGCAL01 procedures to establish 
the shop calendar.  

� In this application, enter required parameters using the Processing Options screen. 

� Enter available capacity using the Capacity Centers Display. 

� Define all applicable Work Centers and/or Resources using the Resources Display. 

� Add tasks to your schedule by selecting the Load From Manfact option from the Processing 
menu, and/or the Add Miscellaneous Task option from the Tools menu. 

� Modify your schedule as desired using the Schedule Display. 
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Choose the Calculate Capacity Plan option from the Processing menu, or click on the corresponding 
icon at the top of the screen.  The following message may be displayed: 

 

Click on the [Yes] button to Calculate the Schedule.  If you receive this message, it means that you have 
turned off the option to Automatically Reschedule Operations.  This feature is enabled/disabled using 
the Processing Options screen.  

If you click [Yes] at the Okay to Calculate Schedule Now? prompt, the system will perform the same 
updates as the Reschedule All option available from the Tools menu.  Please refer to the discussion of 
Scheduling Tools for more information.  Note, this action will likely result in changes to some or all of 
the start and/or due dates in your schedule (depending on the scheduling method(s) you are using).  If 
you choose [No], the capacity calculation will not be performed. 

Messages displayed on the status bar on the lower left corner of the screen allow you to monitor the 
progress of the capacity plan calculation.  Once the capacity calculation has been successfully 
performed, the Capacity Results tab is displayed. 

Post Schedule Changes to Manfact 
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This option allows you to update the Manfact system with any or all of the following: 

Option Description 

Project Start and 
Due Dates 

The Manfact PROJECT file is updated with the Start and Due Date for each project 
and sub-project in the schedule. 

Project Budget 
Labor Hours 

The Manfact PROJBUD file is updated with remaining labor hours for each project 
resource included in your schedule.  Both Estimate to Complete (ETC) and Estimate 
At Complete (EAC) values may be affected. 

Project Budget 
Labor Amounts 

Before updating labor hours or amounts, the system determines the labor rate for 
each resource based on existing Estimate At Complete (EAC) information in the 
PROJBUD file: 

Labor Rate = Total EAC Amount / Total EAC Hours 

If there is no existing EAC information for the resource, the default rate entered in 
the Manfact TABLE.WO screen is used. 

After labor hours have been updated, the ETC and EAC hours are extended by the 
Labor Rate to calculate the corresponding labor amounts for each resource. 

Work Order 
Start and Due 
Dates 

If the work order has not been released (status = “N” or “O”), the Release Date in 
the WO file is updated with the Start Date from your schedule. 

The Work Order scheduled complete date is updated with the Due Date from your 
schedule regardless of the work order status. 

The start and due dates for each operation are also updated to match your schedule.  
This information is used in a variety of Manfact reporting procedures including 
dispatch lists. 

Work Order 
Scheduling 
Methods 

The work order scheduling method (forward, backward, or manual) may be updated 
to match the information in your schedule. 

Work Order 
Routing Hours   

The estimated Setup, Run, and Rework hours for each operation are updated to 
match your schedule.  

Note, this option is not available for standard cost work orders, as it would impact 
the calculation of variances. 

 
Also, if Projects are selected you have the option of updating All or a specified Project Number.  If 
Work Orders are selected you have the option of updating All or a specified Work Order Number. 
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Tools  

Add a Budget Row to a Project 
This option allows you to add a new budget line to an existing project in your schedule.  
 

 

The system prompts for the following information: 

Prompt Description 

Project Number The new budget line will be inserted below the project number you specify here.  
This project number must already appear in your schedule. 

Resource Code The resource code entered at this prompt must first be defined using the Resources 
tab. 

Fiscal Period This field is prompted only if you have enabled the Use Budget Periods as Schedule 
Dates option in the Processing Options screen. 
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Add a Misc. Task to the Schedule 
Use this option to include a miscellaneous task in your schedule.  This allows you to include non-
production activities in your plan when there are no corresponding projects or work orders in Manfact. 

 

 
Note, miscellaneous lines are ignored when you choose the option to Post Schedule Changes to 
Manfact.  The next time you reload your schedule from Manfact, these items will not reappear. 

The following prompts are displayed when you choose this option from the Tools menu: 

Prompt Description 

Task Identifier The task identifier for miscellaneous lines is user defined, however each one must 
be unique. 

Work Center or 
Resource 

The resource code entered at this prompt must first be defined using the 
Resources Display. 

Description Enter a description of this task (free form). 

Assembly Number Optionally, you may enter an assembly number to further describe this task. 

 
Once the required information has been entered, click the [OK] button and the task will be added to your 
schedule.  You may now enter additional information including estimated labor hours, machine hours, 
and schedule dates using the Schedule / Load Display. 

Delete Task(s) From the Schedule 
This option allows you to delete one or more tasks from your schedule.  Note, it is not possible to delete 
records from Manfact using this application. 

You must first select the task(s) to be deleted using the Schedule Display.  To select multiple tasks, click 
on the row numbers in the left-most column.  Hold down the left mouse button, and drag the mouse until 
the desired rows are highlighted.  
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Once the desired row(s) have been selected, the system responds with a message: 

Okay to Delete Rows ___ Through ___ from the Schedule? 

Choose [Yes] to delete the selected rows, otherwise choose [No]. 

Note, the system may respond with more rows to be deleted than you initially selected.  This is because 
you cannot delete only a portion of a work order or project – all of the operations or sub-tasks beneath  

Loading Resources From Manfact 
The tasks in your schedule will place load on various resources.  These resources may be a combination 
of Manfact work centers and/or project resource codes.  All of the resources used in your plan must be 
defined using the Resources tab. 

Select the Load Resources From Manfact option from the Tools menu to copy resource information 
from the Manfact database into your plan.  You may choose to load either work centers or project 
resource codes.  Choosing one of these options may append rows to your resource list, but it will not 
replace or override any existing information. 

If you choose to load work centers, one row will be added for each record in the Manfact WKC file.  If 
you choose to load project resources, one row will be added for each labor resource that has been 
defined using TABLE.WO (material, overhead and outside processing resource codes are not loaded). 

Creating Capacity Centers 
A Capacity Center represents a group of resources that you wish to combine for the purposes of 
analyzing the demand (load) being placed on those resources.  For example, a Capacity Center might 
represent a department, a group of machines, or a single work center.  The Cap. Centers tab allows you 
to create as many Capacity Centers as you wish to effectively manage you schedule. 

Select the Create Capacity Centers option from the Tools menu to automatically setup Capacity Centers 
based on the information on your Resources tab.  You may choose to create one Capacity Center per 
Department (based on the first three characters of the Work Center identifier), or you may choose to 
create one Capacity Center per Work Center. 

If you have previously used the WKC.N procedure to load capacity information (crew size, hours per 
shift, etc.) into your Manfact system, the Create Capacity Centers option will update the Capacity 
Centers Display with the available data.  Once loaded, you may change this information as desired (the 
Manfact system will not be affected). 

Update Manufacturing Calendar 
The Manufacturing Calendar is entered on the Processing Options screen.  If you change the Shop 
Calendar you will need to run this procedure to update the calendar used in your schedule. 
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Scheduling Tools 
The process of scheduling a Work order, MRP Planned Order or Project accomplishes two main goals.  
First, it determines the number of work days required to complete the task (duration).  The duration 
determines either the end date or start date of the task depending on whether you are using forward or 
backward scheduling.  

The second goal of the scheduling operation is to calculate the number of labor and/or machine hours to 
be loaded into the Capacity Center for the dates work is scheduled to be performed.  So, even if a task is 
manually scheduled (meaning you will supply the start and end dates for the task), the system must 
“schedule” each task in order to calculate the load. 

If you have enabled automatic rescheduling (please refer to the Process Options topic), the system will 
compute the load for a task when you change pertinent information such as the start date or the 
scheduling method.  Otherwise, a “Need Reschedule” message will be displayed on the bottom of the 
screen indicating that the scheduling logic must be performed before the Capacity Plan can be 
calculated.  This message will also be displayed if you make changes to available capacity using the 
Capacity Centers tab. 

The following options are available from the Tools menu: 

Option Description 

Reschedule All This option will reschedule each task in your schedule.  You should 
choose this option if you have made changes to your available capacity 
information (which may result in changes to your schedule dates), or 
anytime you see the “Need Reschedule” message displayed at the bottom 
of the screen. 

Roll-up Project Schedule 
Dates 

This option will allow you to roll-up schedule dates based on the project 
structure.  The start date of a project will be the earliest date assigned to 
any sub-project or work order below it, and the end date of a project will 
be the latest date assigned to any lower level task.  Note, this tool is not 
required if you have chosen to roll up dates automatically (using the 
Process Options screen). 

Reschedule Work Orders 
Within Project Dates 

This option attempts to force all work orders to be scheduled within the 
start and end dates of the projects they are linked to.  If the work order 
uses the forward scheduling method, it will be updated with the project 
start date, and then scheduled forward from that point.  Conversely, if the 
work order uses backward scheduling, it will inherit the project end date. 

Push All Start Dates 
Forward to Plan Start 

This option will reschedule any past due tasks by setting the start date 
equal to the plan start, and forward scheduling from that date. 
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Find a Task in the Schedule 
This feature may be used to locate a specific item on the Schedule Display.  For example, if you wanted 
to locate a specific work order in your schedule, you could search the Task Identifier column for the 
desired work order number. 

 
 

Prompt Description 

Search Field Select the field you wish to search on.  Select the Field from the drop-
down window. 

Find Text Enter the text you are searching for. 

Match Case Check this box if you care whether letters are in upper or lower case. 

Match Whole Field Only Check this box if you want the entire field to equal the text you typed in 
the Find Text box.  Otherwise, it will be considered a match if the text is 
contained anywhere in the field 

 
Click the [OK] button to begin the search. 
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Reporting 

Graph Capacity Results 
This option produces a bar graph that will chart your Capacity Results for all or selected work centers. 
Two different formats are available. 

Capacity/Load by Time displays one bar for each Capacity Center for each period in the planning 
horizon: 
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Capacity/Load by Center displays one bar for each Capacity Center representing the total summarized 
capacity and load for the selected date range: 

 
 
Double-click on any point in the graph to jump to the corresponding row in the Capacity Results 
Display. 
 

The following options allow you to change the information displayed in your graph: 

Option Description 

Date Range (From/To) Use the drop-down lists to select the From and To dates to be included in 
your graph.  Note, the dates available correspond to the dates defined for 
each bucket in your planning horizon. 

Show When Capacity is 
Zero 

Check this box to include Capacity Centers in your graph even though 
total capacity is zero. 

Show When Load is Zero Check this box to include Capacity Centers in your graph even though 
total load is zero. 

Select Capacity Centers This option allows you to choose the Capacity Centers to include in your 
graph.  
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Option Description 

Reload After changing any of the above options, click the [Reload] button to re-
display the graph. 

Print Click the [Print] button to output the graph to your printer. 

Close Click the [Close] button to close the graph and return to the main screen. 

 

Production Group Definition 
This option allows you to define a Production Group that will be included in your Reports. 

 
 
To create a new group click on the [New Group] button and the following pop-up window will appear. 
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� Enter the Name for the New Production Group and click [OK]. 

� Enter the Description of the New Production Group. 

� Select the type of hours to be reported by clicking on the appropriate radio button (Labor or 
Machine). 

� Enter the Over-Time Modifier. 

� Click on the Exclude from Summary Sheet check box if you want this Production Group 
excluded from the Summary Sheet. 

� You may individually select Capacity Centers to be included or click on the [Select All] button 
to select all Capacity Centers.  To erase selections click on the [Select None] button. 

� Once completed click on the [Save Group] button to save the Production Group. 

� You may delete the group at anytime by clicking on the [Delete Group] button. 

Generate Production Capacity Workbook 
Choose this option to create an Excel Workbook based on the Production Group Definitions previously 
established. 
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To create a new report click on the [New Report] button and the following pop-up window will appear. 

 
 

� Enter a Name for the Report and click [OK]. 

� Enter a Summary Sheet Name 

� Enter the path to your Excel template. 

� Enter the path where you want to save the report. 

� Select the Production Groups to be included.  To select all click on the [Select All] button.  To 
erase selections click on the [Select None] button. 

� Click on the [Save Report] button to save the report definition. 

� To generate a report click on the [Generate Report] button found in the upper right hand corner 
of the page. 
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General Information 

Printing a Spreadsheet 
Below is a sample of the screen that will appear when you select the Print option.  This will print the 
current active spreadsheet, so be sure to click on the spreadsheet you wish to print before choosing the 
Print option. 
 

 
 
Range - Selecting a Print Range 

You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted 
on the current screen), the current page (only the rows that are currently visible on your screen), or a 
range of page numbers.  

Orientation - Portrait or Landscape  

You may print your report in portrait mode (normal) or landscape mode (sideways).  Printing in 
landscape mode will allow you to fit more columns of information on your report.  

Margins - Report Margins  

You can make your report more attractive by setting the top, bottom, left, and right margins.  Reduce 
the left and right margins if you need to fit more columns on the report.  
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Units - Inches or Centimeters?  

Are the margins you entered expressed in inches or centimeters?  

Page Order  

If your report is too wide, it may span multiple pages.  When this occurs, do you want the report 
printed from top to bottom or left to right?  

What Do You Want to Print?  

You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  

Your report may have up to three lines for the heading, and one line for the footer.  The system 
initially displays a default heading, which you may modify if desired.  

Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  
The columns that are available for printing are listed. Select the columns you wish to include on your 
report.  

Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 
 

 
 
Save As File Name 

Enter the pathname of the file you wish to create.  You may Browse the files by clicking the button to 
locate the drive and folder where the file will be stored. 
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Sheet Name 

Enter the Excel sheet name to create.  This will automatically default to Sheet1. 

Export to Excel or to a File? 

You may export the contents of the display directly to Excel, or you may choose to create a file in 
Excel format. 

Create a Log File? 

Select this option to create a log file.  The log file contains error messages and other information 
about how your Excel file was created.  The name of the log file is "CreateExcelFile.log", and it will 
be stored in the same folder as your spreadsheet. 

Export Button 

After all required information has been entered, click this button to export your data to Microsoft 
Excel. 

Editing Features 
Copy, Cut, Paste and Fill 
You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  

To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. 
There are multiple ways to enter this command:  

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, and then choose Copy from the pop-up menu.  

3.  Click the corresponding icon on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  

To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy.  Now click on the row header that you want to copy the 
data to and choose Paste. 

If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells.  This command will update each cell with the current information from the clipboard. 
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 Zoom 
This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

• You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu, clicking the 
magnifying glass on the toolbar, or selecting Zoom from the right click menu.   

• The Column Name will appear in the Title Bar with "Edit" or "View".  You may edit the field 
when it is allowed.   Click "OK" when finished, or "Cancel" to revert to the original data.  

• To print the selected item, click on the printer icon and the information will be sent to your local 
printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, "View" 
will appear in the Title Bar, and there will only be a single command button labeled "Done". 
 

Customizing Your Display / Arranging Columns 
Use the Customize Display Screen to make the following changes:  

� Each tab contains a list of fields that corresponds to a screen used in this application.  Use the 
checkboxes to show or hide each field.  

� Use the [Move Up] and [Move Down] Buttons to re-arrange the order in which the fields appear 
on the specific screen Display.  Click [Reset All] to return to the system’s default settings. 

� Select the color to use for highlighting Total Rows. When you click the [Select Color…] button, 
a dialog is displayed allowing you to select a color palette. 

� Select whether you choose to indent by level based on Task Number or Description or leave 
blank to not indent at all. 

� Click "OK" to apply any changes you have made or "Cancel" to revert to the previous settings. 
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Note, these settings are stored in the Windows Registry for each user. 
 

Wildcarding 
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 
 

Prompt User Entry Result 

Part No. XTR…  
or XTR* 

Returns part numbers that begin with “XTR”  

Description …VALVE… 
or *VALVE* 

Returns parts with the word “VALVE” anywhere in the description.  

Category …A  
or *A 

Returns parts with a category ending with the letter “A”.  

 

45 


	Introduction
	Quick Start Guide
	Main Menu Options
	Spreadsheet “Right Click” Menu

	Capacity Planning and Scheduling
	Schedule
	Operations
	Capacity Centers
	Resources
	Capacity Override
	Capacity Results
	Load Detail

	Capacity Planning Database
	Open / Create a Database
	Save Changes and Post Later
	Revert to Last Save

	Processing
	Processing Options
	Load Projects, WO’s and MRP From Manfact
	Calculate Capacity Plan
	Post Schedule Changes to Manfact

	Tools
	Add a Budget Row to a Project
	Add a Misc. Task to the Schedule
	Delete Task(s) From the Schedule
	Loading Resources From Manfact
	Creating Capacity Centers
	Update Manufacturing Calendar
	Scheduling Tools
	Find a Task in the Schedule

	Reporting
	Graph Capacity Results
	Production Group Definition
	Generate Production Capacity Workbook

	General Information
	Printing a Spreadsheet
	Exporting a Spreadsheet to Excel
	Editing Features
	Customizing Your Display / Arranging Columns
	Wildcarding



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /ENU (Use these settings to create PDF documents with higher image resolution for high quality pre-press printing. The PDF documents can be opened with Acrobat and Reader 5.0 and later. These settings require font embedding.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


